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Preface

The GNOME 2.0 Desktop for the Solaris Operating Environment Accessibility Guide
describes how to configure, customize, and use the accessibility features of the
GNOME 2.0 desktop for the Solaris™ 8 operating environment and the Solaris 9
operating environment.

Who Should Use This Book
This manual is for users, system administrators, and anyone who is interested in how
the GNOME 2.0 desktop satisfies Section 508 of the U.S. Rehabilitation Act.

How This Book Is Organized
This manual is structured in the following manner:

� Chapter 1 introduces you to accessibility in the GNOME desktop.

� Chapter 2 describes how to configure the mouse and keyboard to make these
devices accessible to more users.

� Chapter 3 describes how to navigate the desktop from the keyboard only.

� Chapter 4 describes the methods you can use to change the appearance of the
desktop to enhance the accessibility of the desktop for users with visual
impairments.
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Related Books
The following manuals are related to this manual:

� GNOME 2.0 Desktop for the Solaris Operating Environment Installation Guide

� GNOME 2.0 Desktop for the Solaris Operating Environment Release Notes

� GNOME 2.0 Desktop for the Solaris Operating Environment System Administration
Guide

� GNOME 2.0 Desktop for the Solaris Operating Environment Troubleshooting Guide

� GNOME 2.0 Desktop for the Solaris Operating Environment User Guide

Accessing Sun Documentation Online
The docs.sun.comSM Web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. The URL is http://docs.sun.com.

Ordering Sun Documentation
Sun Microsystems offers select product documentation in print. For a list of
documents and how to order them, see “Buy printed documentation” at
http://docs.sun.com.

Typographic Conventions
The following table describes the typographic changes used in this book.
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TABLE P–1 Typographic Conventions

Typeface or Symbol Meaning Example

AaBbCc123 The names of commands, files, and
directories; on-screen computer output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with
on-screen computer output

machine_name% su

Password:

AaBbCc123 Command-line placeholder: replace with
a real name or value

To delete a file, type rm
filename.

AaBbCc123 Book titles, new words, or terms, or
words to be emphasized.

Read Chapter 6 in User’s Guide.

These are called class options.

You must be root to do this.

Shell Prompts in Command Examples
The following table shows the default system prompt and superuser prompt for the C
shell, Bourne shell, and Korn shell.

TABLE P–2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell prompt $

Bourne shell and Korn shell superuser prompt #
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CHAPTER 1

Introduction to Accessibility

This chapter introduces you to accessibility in the GNOME desktop.

Overview of Accessibility
The core business of Sun Microsystems is to connect people to information and
services, including people with disabilities. Therefore, a key goal of Sun Microsystems
is to provide a desktop that incorporates accessibility features to enable people with
disabilities to use the desktop easily and efficiently. Recent legislation such as Section
508 of the U.S. Rehabilitation Act also heightens awareness of the need to provide
accessible software.

The GNOME desktop is easy to use and incorporates many accessibility features.
Every application and utility in the desktop is designed with accessibility and
usability in mind. Users with physical disabilities such as low vision or impaired
motor skills can use all of the functionality of the desktop thanks to the customization
tools that are available. The customization tools enable you to customize the
appearance and behavior of the desktop.

The customizability of the desktop contributes greatly to the accessibility of the
desktop. This manual describes the various customization options that you can use to
tailor the desktop to suit your particular needs.
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CHAPTER 2

Configuring the Mouse and Keyboard

This chapter describes how to configure the mouse and keyboard to make these
devices accessible to more users.

Configuring the Mouse
Use the Mouse preference tool to configure the mouse to suit your needs. To open the
Mouse preference tool, choose Applications → Desktop Preferences → Mouse. The
Mouse Preferences dialog is displayed.

To Configure the Behavior of the Mouse
The following sections describe how to modify the behavior of the mouse to suit your
needs.

To Configure the Mouse for Left-Handed Use
To configure the mouse for left-handed use, click on the Buttons tab in the Mouse
Preferences dialog, then select the Left-handed mouse option. When you select this
option, the system swaps the functions of the left mouse button and the right mouse
button immediately.
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To Configure the Double-Click Behavior
If you have difficulty double-clicking, you can increase the period of time that the
system allows to elapse between the first click and the second click of a double-click.
For example, if the double-click timeout setting is 0.4 seconds, you must perform the
second click of a double-click within 0.4 seconds of the first click. If the second click
occurs more than 0.4 seconds after the first click, the system interprets the two clicks
as two single clicks.

To configure the double-click timeout setting, perform the following steps:

1. Click on the Buttons tab in the Mouse Preferences dialog.

2. Use the Delay slider to specify the timeout in seconds that the system allows
between the two clicks of a double-click.

3. Double-click on the light bulb to the right of the slider to test the setting. If you
perform the two clicks of the double-click within the timeout specified, the light
bulb lights up fully to display a yellow glow around the bulb. If you do not
double-click within the timeout specified, the light bulb does not light fully. You
should increase the timeout setting and try again. When the light bulb lights, the
timeout setting is suitable for your needs.

To Configure the Speed and Sensitivity of the Mouse
To configure the speed and sensitivity of the mouse, perform the following steps:

1. Click on the Motion tab in the Mouse Preferences dialog.

2. Configure the following options:

Acceleration Use the slider to specify the speed at which the mouse pointer
moves around the screen when you move your mouse.

If you select a low setting, the mouse pointer moves at a speed
similar to the speed at which you are physically moving the
mouse. This means that you need to physically move the mouse
larger distances to cover the screen area. If you select a high
setting, the mouse pointer moves at a faster speed than the speed
at which you are physically moving the mouse. This means that
you need to physically move the mouse small distances to cover
the screen area.

Sensitivity Use the slider to specify how sensitive the mouse pointer is to
movements of your mouse.

Threshold Use the slider to specify the distance that you must move an item
before the system interprets the move action as a drag-and-drop
action.
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To Locate the Mouse Pointer
If you have difficulty locating the mouse pointer on the screen, you can enable an
option to highlight the pointer when you press the Control key. To enable this option,
click on the Cursors tab in the Mouse Preferences dialog, then select the Show
position of cursor when the Control key is pressed option. When you press Control,
the system displays an animation around the pointer to highlight the pointer.

To Configure the Mouse Pointer
The following sections describe how to modify the display characteristics of the
pointer.

To Change the Pointer
To select the type of pointer that is displayed on the desktop, perform the following
steps:

1. Click on the Cursors tab in the Mouse Preferences dialog.

2. Select one of the following themes from the pointer themes that are listed in the
Cursor Theme list box:

� Default Cursor

Displays the default black pointer.

� White Cursor

Displays a white pointer that is the same size as the default pointer.

� Large Cursor

Displays a large black pointer.

� Large White Cursor

Displays a large white pointer.

3. To change the pointer theme, you must log out of your session and log in again.

To Stop the Cursor Blinking
To stop the cursor blinking in text boxes and fields, perform the following steps:

1. Choose Applications → Desktop Preferences → Accessibility → Keyboard to start
the Keyboard Accessibility preference tool.

2. Click on the Repeat Key Preferences button. The Keyboard Preferences dialog is
displayed.
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3. In the Keyboard tabbed section, deselect the Blinks in text boxes and fields
option.

To Use the Keyboard to Emulate the Mouse
If you have difficulty using a mouse, you can use the keyboard to emulate the mouse
functions. See “To Enable the Keyboard to Emulate the Mouse” on page 18 of this
manual for more information.

Configuring the Keyboard
Use the Keyboard Accessibility preference tool, also known as AccessX, to configure
the keyboard accessibility options. To start AccessX, choose Applications → Desktop
Preferences → Accessibility → Keyboard.

The AccessX dialog enables you to customize your keyboard in the following ways:

� To use the numeric keypad to emulate mouse actions. See “To Enable the Keyboard
to Emulate the Mouse” on page 18.

� To specify the duration for which you must press-and-hold a key before the system
accepts the keypress. See “To Enable the Slow Keys Feature” on page 19.

� To ignore rapid, repeated keypresses of the same key. See “To Enable the Bounce
Keys Feature” on page 20.

� To accept key combinations in sequence rather than simultaneously. See “To Enable
the Sticky Keys Feature” on page 20.

� To emit an audible notification when a user activates or deactivates a toggle key.
See “To Enable Audible Notifications for Toggle Keys” on page 22.

� To ignore long keypresses of the same key and control the repeat rate of a keypress.
See “To Enable the Repeat Keys Feature” on page 22.

Before You Can Use AccessX
Before you can use the AccessX preference tool, you must enable XKB on your Solaris
system.

Note – XKB is not currently supported on Sun Ray™ systems.
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To enable XKB on a non-Sun Ray system, perform the following steps:

1. Log in as root.

2. Check if the path and file /etc/dt/config/Xservers exists on your system.

3. If the /etc/dt/config directory does not exist, enter the following command:

mkdir -p /etc/dt/config

4. If the Xservers file is not present, enter the following command:

cp /usr/dt/config/Xservers /etc/dt/config/Xservers

5. Open the Xservers file in a text editor and scroll to the end of the file.

6. Append the following to the command line at the end of the file:

+kb

7. Save and close the file.

8. Enter the following command at a command line:

pkill -HUP dtlogin

9. Log out of your GNOME session and log in again.

10. To verify if XKB is running, enter xdpyinfo and search for XKEYBOARD in the
extensions list.

To Activate the Keyboard Accessibility Options
To activate the keyboard accessibility options, perform the following steps:

1. Select the Enable keyboard accessibility option.

2. Select the Beep when enabling/disabling keyboard accessibility features option
to receive an audible notification each time a user enables or disables a keyboard
accessibility option using the following keyboard shortcuts:

� Press-and-hold Shift for eight seconds to enable or disable the slow keys
feature.

� Press Shift five times to enable or disable the sticky keys feature.

3. To automatically disable the keyboard accessibility options if the options are not
used for a specified number of seconds, select the Disable if unused for X seconds
option. Use the slider to specify the number of seconds of keyboard idle time
required before the system disables the keyboard accessibility options.

This option is intended for computers that are shared by a number of different
users, some of whom require the keyboard accessibility options.
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To Enable the Keyboard to Emulate the Mouse
The mouse keys feature enables you to use the numeric keypad on the keyboard to
emulate mouse actions. This feature benefits users who have difficulty using a mouse
or other pointing device. To enable and configure the mouse keys feature, perform the
following steps:

1. Select the Enable Mouse Keys option.

2. Configure the following options to determine the behavior of the mouse pointer
when you control the pointer from the numeric keypad:

Maximum pointer speed Use this spin box to specify the
maximum speed, in pixels per second, at
which the pointer moves around the
screen.

Time to accelerate to max speed Use this spin box to specify the duration,
in milliseconds, before the pointer
accelerates to the maximum pointer
speed.

Start moving this long after keypress Use this spin box to specify the interval,
in milliseconds, between a keypress and
the time when the pointer starts to
move.

When you enable mouse keys, the keys on the numeric keypad have the following
functions:

TABLE 2–1 Numeric Keypad to Mouse Functions Mapping

Numeric Keypad Keys Function

1, 2, 3, 4, 6, 7, 8, 9 Move the mouse pointer around the screen

5 Mouse button click

0 Mouse button double-click

. Mouse button press

/ Mouse button 1

* Mouse button 2

− Mouse button 3

Some systems also use the function keys to emulate the mouse buttons. The common
function key to mouse button mappings are described in the following table.
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TABLE 2–2 Function Keys to Mouse Functions Mapping

Function Key Function

F2 Mouse button 1

F3 Mouse button 2

F4 Mouse button 3

To Enable the Slow Keys Feature
The slow keys feature enables you to customize how the keyboard handles user input
in the following ways:

� Specify the duration for which you must press-and-hold a key before the system
accepts the keypress. This aspect of the feature benefits users who frequently press
keys that they do not intend to press.

� Enable audible indications of keyboard input and acceptance. This aspect of the
feature benefits users who cannot see the result of a keypress.

To enable and configure the slow keys feature, perform the following steps:

1. Select the Enable Slow Keys option.

Tip – To select or deselect this feature from the keyboard, press-and-hold Shift for
eight seconds. This keyboard shortcut automatically selects all of the slow keys
options. If you selected the Beep when enabling/disabling keyboard accessibility
features option, after four seconds the system beeps three times to indicate that the
system is about to select or deselect the feature. If you enable this feature from the
keyboard, you must press-and-hold Shift for eight seconds again to disable the
feature.

2. Use the Only accept keypress after x msecs slider or spin box to specify the
duration, in milliseconds, for which you must press and hold a key before the
system accepts the keypress. Use the Testing Area to test the slow keys setting and
modify the setting as required.

3. To enable audible indications of keyboard input and acceptance, select the
following options:

Beep when key is pressed Select this option to hear a beep when you press a
key.

Beep when key is accepted Select this option to hear a beep when the system
accepts a keypress.

Beep when key is rejected Select this option to hear a beep when the system
rejects a keypress. The system rejects a keypress if
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you do not press-and-hold the key for the duration
that is specified in the Only accept keypress after x
msecs setting.

To Enable the Bounce Keys Feature
The bounce keys feature enables you to customize the keyboard to ignore rapid,
repeated keypresses of the same key. For example, users with impaired motor skills
might press the same key several times when they intend to press the key once. This
feature enables you to customize the keyboard to ignore repeated keypresses.

To enable and configure the bounce keys feature, perform the following steps:

1. Select the Enable Bounce Keys option.

2. Use the Ignore keypresses within x msecs slider or spin box to specify the
duration after the first keypress for which the system ignores repeated keypresses
of the same key. For example, if you select a duration of 500 msecs, the system
ignores all repeated keypresses of the same key that occur within 500 msecs of the
first keypress.

3. Select the Beep when key is rejected option to hear an audible indication when the
system ignores a key.

Note – If you wish to enable the bounce keys feature, please ensure that the Enable
Slow Keys option is deselected. The slow keys feature requires you to press a key for
a specified duration before the system accepts the keypress as a valid keypress. If you
cannot press the key for the duration that is specified by the slow keys setting, the
system does not accept your input unless you deselect the Enable Slow Keys option.

To Enable the Sticky Keys Feature
The sticky keys feature enables you to press the keys in a key combination in sequence
rather than simultaneously. This feature is designed for users who are unable to press
two or more keys simultaneously.

To enable and configure the sticky keys feature, perform the following steps:

1. Select the Enable Sticky Keys option.
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Tip – To enable the sticky keys feature from the keyboard, press Shift five times.
This keyboard shortcut automatically selects all of the sticky keys options. If you
selected the Beep when enabling/disabling keyboard accessibility features
option, the system beeps to indicate that the system is about to select or deselect
the feature. If you enable this feature from the keyboard, press Shift five times
again to disable the feature.

2. Select the Beep when modifier is pressed option to receive an audible indication
each time you press a modifier key. This option is useful to remind you whether a
modifier key is active or inactive.

3. To automatically disable the sticky keys feature when a user presses two keys
simultaneously, select the Turn off Sticky Keys when two keys pressed
simultaneously option.

You can use the sticky keys feature in latch or lock mode. The following table
describes how to choose a mode and the difference between the two modes.

TABLE 2–3 Sticky Keys Latch or Lock Mode

To use the sticky keys feature in... Press the modifier key...
The modifier key stays active
until...

Latch mode Once. You press a non-modifier key.

Lock mode Twice in quick succession. You press the modifier key
again.

For example, if you want to press Alt + F1, you should do the following:

1. Press Alt to latch the modifier key. The Alt key remains active.

2. Press F1. The key combination is now complete. After you press F1, the Alt
modifier key is no longer active.

As another example, if you want to press Ctrl + Alt + Tab, you should do the
following.

1. Press Ctrl twice to lock the modifier key. The Ctrl remains active.
2. Press Alt.
3. Press Tab. The key combination is now complete.
4. To unlock the modifier key, press Ctrl again.
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To Enable Audible Notifications for Toggle Keys
A toggle key is any key on the keyboard that can switch between two states. The Num
Lock, Caps Lock, and Scroll Lock keys are toggle keys. Most toggle keys have an
associated light emitting diode (LED) on the keyboard that lights when the toggle key
is active. To assist users with visual impairments, you can customize the keyboard to
emit an audible notification when a user presses a toggle key. For example, when you
press Num Lock, you can determine whether the key is toggled or not toggled by the
sound.

To enable accessible toggle keys, select the Enable Toggle Keys option. When you
activate the Num Lock, Caps Lock, or Scroll Lock keys, the system beeps once. When
you deactivate a toggle key, the system beeps twice.

To Enable the Repeat Keys Feature
The repeat keys feature enables you to repeat a keystroke multiple times without
pressing the key more than once. This feature is designed for users who cannot release
keys quickly, for example users who operate a mouth stick. When you enable repeat
keys, you can specify the duration for which you must press a key before the key
starts to repeat.

To enable and configure the repeat keys feature, perform the following steps:

1. Click on the Repeat Key Preferences button. The Keyboard Preferences dialog is
displayed.

2. Select the Keyboard repeats when key is held down option to enable the repeat
keys feature.

3. Use the Delay slider to specify the duration for which you must press a key before
the keyboard interprets the action as a repeat key. If you have difficulty releasing
keys, select a long time delay.

4. Use the Speed slider to specify the speed at which the keyboard repeats the
keypress as input.
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CHAPTER 3

Using the Keyboard to Navigate the
Desktop

This chapter describes how to navigate the desktop from the keyboard only. Users
who have difficulty using a mouse or other pointing device can navigate and use the
desktop from the keyboard.

Introduction to Keyboard Navigation
This section describes the essential keyboard shortcuts to enable you to navigate the
desktop from the keyboard.

You can customize some of the keyboard shortcuts that are described in this chapter.
The text indicates the shortcuts that you can customize. See “Customizing Your
Keyboard Shortcuts” on page 50 for information about how to customize keyboard
shortcuts.

Essential Keyboard Shortcuts
The following table lists the essential keyboard shortcuts that you can use to navigate
the desktop. The keyboard shortcuts that you use to navigate specific desktop
elements and controls are described in the appropriate sections of this chapter.

Keys Function

Tab Give focus to the next desktop element or control.
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Keys Function

Shift+Tab Reverse the navigation direction and give focus to
the previous desktop element or control. In general,
the Shift key reverses the navigation direction.

Ctrl+Tab If the Tab key has a specific purpose in a control,
press Ctrl+Tab to give focus to the next element or
control. For example, if you press Tab in a text box,
the system inserts a tab space.

To give focus to the previous element or control,
press Shift+Ctrl+Tab.

arrow keys Navigate within a desktop element or control.

spacebar Activate the element or control that has focus. For
example, if the current control is a button, this action
is the equivalent of clicking on the button with a
mouse.

Esc Close a window, menu, or drawer.

Global Keyboard Shortcuts
The following table lists the keyboard shortcuts that you can use from any part of the
desktop.

Keys Function

Alt+F1 Open the Main Menu at the location of your mouse
pointer.

You can customize this keyboard shortcut.

Alt+F2 Open the Run Program dialog.

You can customize this keyboard shortcut.

Print Screen Take a screenshot of the entire screen.

You can customize this keyboard shortcut.

Alt+Print Screen Take a screenshot of the window that currently has
focus.

You can customize this keyboard shortcut.

F1 If the focused desktop element is an application
window or dialog, this keyboard shortcut opens the
online help for the application.
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Keys Function

Ctrl+ F1 If the focused desktop element is a panel or
application window, this keyboard shortcut switches
the display of tooltips for the window or panel
objects on and off.

Shift+ F10 Open a popup menu for the desktop element that
has focus, if a popup menu exists.

Navigating the Desktop Background
The desktop background is the part of the desktop where there are no interface items
or applications, such as panels and windows. The following table lists the keyboard
shortcuts that you can use to navigate the desktop background and the desktop
background objects. A desktop background object is an icon on the desktop
background that you can use to open files, folders, or applications.

Keys Function

Ctrl+Alt+D Temporarily hide all windows and give focus to the
desktop background.

To restore the windows, press Ctrl+Alt+D again.

You can customize this keyboard shortcut.

Ctrl+ Alt+Tab Display a popup window with icons that represent
the desktop background and the panels.
Press-and-hold Ctrl+Alt and continue to press Tab to
switch the focus between the desktop background
and the panels.

You can customize this keyboard shortcut.

Tab When the desktop background or a desktop
background object has focus, give focus to the next
desktop background object in alphabetical order.

arrow keys When the desktop background or a desktop
background object has focus, give focus to a
neighboring desktop background object.

A sequence of characters that matches
the first n characters of a desktop
background object name.

When the desktop background has focus, give focus
to the desktop background object whose name starts
with the specified sequence of characters.
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Keys Function

F2 Rename the desktop background object that has
focus.

Shift+F10 Open the popup menu for the desktop background
object that has focus.

Ctrl+F10 Open the Desktop Background menu.

Navigating Panels
A panel is an area on the desktop from which you can run special programs,
applications, and applets. The most common panel is the Menu Panel, which stretches
the full width of the top edge of the desktop. The following table lists the keyboard
shortcuts that you can use to navigate panels and panel objects.

Keys Function

Ctrl+ Alt+Tab Give focus to a panel. This keyboard shortcut
displays a popup window with icons that represent
the desktop background, panels, and drawers.
Press-and-hold Ctrl+Alt and continue to press Tab to
switch the focus between the desktop background,
panels, and drawers.

You can customize this keyboard shortcut.

Tab Give focus to the next object on the panel.

Note – When you navigate the Menu Panel, the Tab
key skips the Applications and Actions menus and
the Window List icon.

F10 Open the Applications menu when the Menu Panel
has focus. Continue to press F10 to switch focus
between the Applications menu and the window list.

spacebar Activate a panel object, for example, open a menu or
start a launcher.

Shift+ F10 Open the panel object popup menu.

Ctrl+F10 Open the panel popup menu.

26 GNOME 2.0 Desktop for the Solaris Operating Environment Accessibility Guide • April 2003



To Move a Panel Object
You can move a focused panel object to a different location on a panel or drawer, or
you can move the object to the next panel. To move a panel object, perform the
following steps:

1. Press Tab to give focus to the object.

2. Press Shift+F10 to open the panel object popup menu.

3. Use the arrow keys to select the Move menu item.

4. Use the keyboard shortcuts that are listed in the following table to perform the
move operation.

Keys Function

arrow keys Move the object left and right on a horizontal
panel or up and down on a vertical panel.

Shift+ arrow keys Move the object and push any objects that you
encounter in front of the object.

Ctrl+ arrow keys Move the object and swap position with any
objects that you encounter in the move.

Tab Move the object to the next panel.

spacebar Complete the move operation.

The following examples demonstrate the effect of different move operations on the
objects in a panel.

The following illustration shows a panel with three panel objects before a move
operation takes place.

The following illustration shows the effect of using the arrow keys to move the Geyes
applet on the panel. You can use the arrow keys to move the applet left or right until
you meet the next panel object.
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The following illustration shows the effect of using the Shift + arrow keys to move the
Geyes applet on the panel. You can use the Shift+ arrow keys to push the Volume
Control and Help panel objects ahead of the object that you are moving.

The following illustration shows the effect of using the Ctrl + arrow keys to move the
Geyes applet on the panel. You can use the Ctrl + arrow keys to swap position with
the Volume Control and Help panel objects as you meet the objects.

To Navigate Drawers
A drawer is a collapsible extension of a panel. The following table lists the keyboard
shortcuts that you can use to navigate into and out of drawers. When you open a
drawer, you can navigate the contents of the drawer in the same way as you navigate
a panel. See “Navigating Panels” on page 26 for information about how to navigate a
panel.

Keys Function

spacebar Open or close the drawer that has focus.

arrow keys Navigate into the drawer that has focus.

Esc Close the drawer and give focus to the drawer object
on the panel.

Shift+Esc Give focus to the drawer object on the panel and
leave the drawer open.
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To Navigate Menus on Panels
The following table lists the keyboard shortcuts that you can use to navigate menus on
panels.

Keys Function

spacebar Open the menu that has focus.

arrow keys Navigate the menu.

spacebar Select a menu item.

Shift+F10 Open the popup menu associated with a menu item,
if one exists.

Esc Close a menu.

To Navigate Applets
An applet is a small application that resides on a panel. You can navigate to all applets
and open the applet popup menu from the keyboard. However, if the applet does not
contain controls that you can give focus to, you cannot navigate the controls in the
applet. The following table lists the keyboard shortcuts that you can use to navigate
applets.

Keys Function

spacebar Activate the applet control that has focus, if
applicable. Not all applets contain controls that you
can activate. If the applet does not contain a control
that you can activate, the spacebar does nothing.

arrow keys Navigate the controls on the applet.

Shift+F10 Open the applet popup menu. To navigate the
menu, use the standard keyboard shortcuts for
navigating menus. See “To Navigate Menus”
on page 39 for information about how to navigate
menus.
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Navigating Your Workspaces
A workspace is a discrete area in which you can work. You can have many workspaces
on your desktop and you can switch from one workspace to another. Each workspace
can contain different windows and processes. The following table lists the keyboard
shortcuts that you can use to navigate workspaces.

Keys Function

Ctrl+ Alt + arrow keys Give focus to the next or previous workspace. This
keyboard shortcut displays a popup window with
icons that represent the workspaces. Press and hold
Ctrl+Alt and continue to press the arrow keys to
switch the focus between the workspaces.

You can customize this keyboard shortcut.

Shift+ Alt + arrow keys Move the window that has focus to the next or
previous workspace.

You can customize this keyboard shortcut.

Navigating Windows
The following sections describe the keyboard shortcuts that you can use to navigate
windows. A window is a rectangular frame on your screen that displays an
application.

Note – You can customize all of the keyboard shortcuts that are associated with
navigating windows. See “Navigating Your Workspaces” on page 30 for more
information.

To Give Focus to a Window
Before you can use or modify a window, you must give focus to the window. The
following table lists the keyboard shortcuts that you can use to give focus to a
window.
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Keys Function

Alt+ Tab Display a popup window with icons that represent
each window. Press-and-hold Alt and continue to
press Tab to move through the windows until you
reach the window to which you want to give focus.

Alt+Esc Raise each window in turn until you reach the
window to which you want to give focus.

To Control a Window
When a window has focus, you can perform various actions on the window. The
following table lists the keyboard shortcuts that you can use to control the window
that has focus.

Keys Function

Alt+ spacebar Open the Window Menu.

Alt+F4 Close the window.

Alt+F9 Minimize the window.

Alt+F10 Maximize the window.

Alt+F5 Restore a maximized window to the original size of
the window.

To Move a Window
When a window has focus, you can move the window around the screen. The
following table lists the keyboard shortcuts that you can use to move a window.

Keys Function

Alt+F7 Start the move operation.

arrow keys Move the window 10 pixels at a time in the direction
of the arrow key.

Ctrl+ arrow keys Move the window one pixel at a time in the
direction of the arrow key.
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Keys Function

Shift + arrow keys Move the window in the direction of the arrow key
to align it with the edge of the nearest window,
panel, or screen edge.

spacebar Complete the move operation and leave the window
in the current position.

Esc Cancel the move operation and restore the window
to the original position.

To Resize a Window
When a window has focus, you can increase or decrease the size of the window. The
following table lists the keyboard shortcuts that you can use to resize the window that
has focus.

Keys Function

Alt+F8 Start the resize operation.

arrow keys Resize the window in the direction of the arrow
keys.

spacebar Complete the resize operation and leave the window
at the current size.

Esc Cancel the resize operation and restore the window
to the original size.

To Navigate Paned Windows
A paned window is a window that is split into two or more panes. The Help browser
and the Nautilus file manager are examples of applications that use paned windows.
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FIGURE 3–1 Example of a Paned Window

The following table describes the keyboard shortcuts that you can use to navigate
windows with panes.

Keys Function

F6 Give focus to the next pane. The system gives focus
to the control that last had focus in the pane.
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Keys Function

F8 Give focus to the first resize handle in the window.
The resize handle is displayed between the panes
and enables you to resize the panes. Press F8 again
to give focus to the next resize handle.

When the resize handle has focus, you can use the keyboard shortcuts that are listed in
the following table to modify the paned window.

Keys Function

arrow keys Move the resize handle by a small amount.

Ctrl + arrow keys Move the resize handle by a large amount.

Home Reduce the size of the pane to the left of the resize
handle for vertical panes, or above the resize handle
for horizontal panes, to the minimum size allowed.

End Increase the size of the pane to the left of the resize
handle for vertical panes, or above the resize handle
for horizontal panes,to the maximum size allowed.

spacebar Set the position of the resize handle and return the
focus to the last control that had focus.

Esc Reset the position of the resize handle to the original
position and return the focus to the last control that
had focus.

Navigating Applications
An application is any program, utility, or other software package that you run on your
desktop. Applications comprise the following standard user interface components:

Windows A window is a rectangular frame on your screen that displays an
application. See “Navigating Windows” on page 30 for information about
how to navigate windows.

Dialogs A dialog is a popup window in which you enter information or
commands. See “Essential Keyboard Shortcuts for Navigating Dialogs”
on page 36 for information about how to navigate dialogs.

Controls A control is an instrument that you use to operate or guide the user
interface. For example, buttons, check boxes, menus, and text boxes are
controls. See “Navigating Standard Elements and Controls” on page 39
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for detailed information about how to navigate the different types of
controls that are available.

This section of the manual describes the essential keyboard shortcuts that you can use
to start using applications and dialogs.

Essential Keyboard Shortcuts for Navigating
Applications
Since there are many applications that you can use in the desktop, this manual does
not describe the keyboard shortcuts that you can use to navigate all of the different
applications. However, the basic keyboard shortcuts are common to all applications.
Access keys also provide an efficient way to navigate an application from the
keyboard. An access key is identified by an underlined letter on a menu or control. In
some cases, you must press Alt in combination with the access key to perform an
action.

The following table lists the essential keyboard shortcuts that you can use to navigate
applications.

Keys Function

F10 Open the first menu on the application menubar.

Alt + access key Open the menu that is associated with the access
key.

access keys Select the menu item that is associated with the
access key.

left arrow and right arrow Switch focus between the menus on the menubar.

up arrow and down arrow Move focus into a menu.

Esc Close the open menus and give focus to the control
that had focus before the menubar.
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Essential Keyboard Shortcuts for Navigating
Dialogs
The following table lists the essential keyboard shortcuts that you can use to navigate
dialogs.

Keys Function

Alt+access key Activate or select a control.

Tab Give focus to the next control.

Ctrl+ Page Up Move to the next tabbed section of the dialog, if the
dialog contains tabbed sections.

Ctrl+Page Down Move to the previous tabbed section of the dialog, if
the dialog contains tabbed sections.

Esc Close the dialog.

Return Perform the default action for the dialog. The default
action is usually to apply the changes and close the
dialog.

Navigating Nautilus File Manager
The Nautilus file manager window contains several components and there are
different keyboard shortcuts defined to navigate each component. The following
graphic illustrates the name and location of each component.
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FIGURE 3–2 Nautilus File Manager Window Components

To Navigate the View Pane
The following table describes the keyboard shortcuts that enable you to navigate the
list and icon views of the file manager view pane. To navigate the music view of the
file manager view pane, see “Navigating Standard Elements and Controls”
on page 39 for information about how to navigate standard user interface controls.
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Keys Function

F6 Switch focus between the side pane and the view
pane.

arrow keys Select the next or previous file or folder in the
direction of the arrow key.

Tab Select the next file or folder in the current order.

Ctrl+ arrow keys Give focus to the next or previous file or folder but
do not select the item.

Ctrl+ spacebar Add the focused file or folder to the current
selection.

spacebar Open the focused file or folder.

A sequence of characters that matches
the first n characters of a filename.

In an icon view, select the first file or folder that
starts with the specified sequence of characters.

Ctrl+ F In a list view, display a popup dialog where you can
enter a sequence of characters that matches the first
n characters of a filename.

To Navigate the Side Pane
The following table describes the keyboard shortcuts that enable you to navigate the
file manager side pane in general.

Keys Function

F6 Switch focus between the side pane and the view
pane.

Shift+ F10 Open the side pane popup menu.

Shift+Tab Switch the focus from the tab contents to the tab
name.

arrow keys Give focus to the next or previous tab name, when a
tab name has focus.

spacebar Display or hide the tab that has focus. The tab name
remains in focus.

Tab Move the focus from the tab name to the tab
contents.

The following table describes the keyboard shortcuts that enable you to navigate the
History tab in the side pane.
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Keys Function

arrow keys Give focus to the next or previous file or folder in
the history list.

spacebar Open the file or folder that has focus in the history
list.

For information about how to navigate the Notes tab of the file manager side pane, see
“To Navigate Text Boxes” on page 41 for information about how to navigate
multi-line text boxes.

For information about how to navigate the Tree tab of the file manager side pane, see
“To Navigate Trees” on page 50.

Navigating Standard Elements and
Controls
The following sections describe how to navigate and use standard user interface
elements and controls from the keyboard.

To Navigate Menus
The following table lists the keyboard shortcuts that you can use to navigate menus.

Keys Function

up arrow and down arrow Give focus to the next or previous menu item on a
menu.

right arrow If the menu item that has focus is a submenu, open
the submenu and give focus to the first menu item
on the submenu.

If the menu item that has focus is not a submenu,
open the next menu on the menubar.

left arrow If the menu item that has focus is a submenu item,
switch the focus back to the submenu.

If the menu item that has focus is not a submenu
item, open the previous menu on the menubar.
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Keys Function

Return Select the focused menu item and close the open
menus.

access key Select the menu item that is associated with the
access key and close the open menus.

spacebar Select the focused menu item and close the open
menus except when the menu item is a check box or
radio button. If the menu item is a check box or
radio button, the menu does not close.

Esc Close the open menus.

To Navigate Buttons
A button is a control that you use to start an action. Most buttons are rectangular and
contain a text label.

FIGURE 3–3 Sample Button

The following table lists the keyboard shortcuts that you can use to navigate buttons.

Keys Function

spacebar Activate the button that has focus. This is the
equivalent of clicking on the button.

Return Activate the button that has focus or, if no button
has focus, perform the default action for the dialog.

To Navigate Radio Buttons
A radio button is a control that you use to select one of several mutually-exclusive
options.

40 GNOME 2.0 Desktop for the Solaris Operating Environment Accessibility Guide • April 2003



FIGURE 3–4 Sample Radio Button

The following table lists the keyboard shortcuts that you can use to navigate a set of
radio buttons.

Keys Function

arrow keys Select the next or previous radio button and deselect
the other radio buttons in the group.

To Navigate Check Boxes
A check box is a control that you use to select or deselect an option.

FIGURE 3–5 Sample Check Box

The following table lists the keyboard shortcuts that you can use to navigate a check
box.

Keys Function

spacebar Select or deselect the check box.

To Navigate Text Boxes
Text boxes are controls in which you type text.

FIGURE 3–6 Sample Single Line Text Box

The following table lists the keyboard shortcuts that you can use to navigate a single
line text box.
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Keys Function

left arrow Position the cursor one character to the left.

right arrow Position the cursor one character to the right.

Ctrl+left arrow Position the cursor at the start of the current word.
Press-and-hold Ctrl and continue to press left arrow
to position the cursor at the start of the previous
word.

Ctrl+right arrow Position the cursor at the end of the current word.
Press-and-hold Ctrl and continue to press right
arrow to position the cursor at the end of the next
word.

Home Position the cursor at the start of the line.

End Position the cursor at the end of the line.

Shift+ left arrow or right arrow Select one character at a time to the left or right of
the cursor.

Shift+Ctrl+left arrow or right arrow Select one word at a time to the left or right of the
cursor.

Shift+ Home Select all text to the left of the cursor.

Shift+End Select all text to the right of the cursor.

Ctrl+A Select all text in the text box.

In addition to the keyboard shortcuts listed in the previous table, use the keyboard
shortcuts in the following table to navigate multi-line text boxes.

Keys Function

Page Up Position the cursor at the top of the current view.
Press Page Up again to position the cursor at the top
of the previous view.

Page Down Position the cursor at the end of the current view.
Press Page Down again to position the cursor at the
end of the previous view.

Ctrl+up arrow Position the cursor at the start of the current
paragraph. Press-and-hold Ctrl and continue to
press up arrow to position the cursor at the start of
the previous paragraph.
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Keys Function

Ctrl+down arrow Position the cursor at the end of the current
paragraph. Press-and-hold Ctrl and continue to
press down arrow to position the cursor at the end
of the next paragraph.

Ctrl+Page Up Position the cursor one view width to the left.

Ctrl+Page Down Position the cursor one view width to the right.

Ctrl+Home Position the cursor at the start of the text box.

Ctrl+End Position the cursor at the end of the text box.

Ctrl+Tab Give focus to the next control on the dialog.

Shift+ Page Up Select the text to the start of the current view.
Press-and-hold Shift and continue to press Page Up
to extend the selection to the start of the previous
view.

Shift+Page Down Select the text to the end of the current view.
Press-and-hold Shift and continue to press Page
Down to extend the selection to the end of the next
view.

Shift+Home Select the text to the start of the line.

Shift+End Select the text to the end of the line.

Shift+Ctrl+up arrow Select the text to the start of the paragraph, then to
the start of the previous paragraph.

Shift+ Ctrl+down arrow Select the text to the end of the paragraph, then to
the end of the next paragraph.

Shift+ Ctrl+Home Select the text to the start of the text box.

Shift+ Ctrl+End Select the text to the end of the text box.

To Navigate Spin Boxes
A spin box is a control that allows you to type a numeric value or select a value from a
list of all possible values.

FIGURE 3–7 Sample Spin Box
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The keyboard shortcuts that you use to navigate the text box area of a spin box are
listed in “To Navigate Text Boxes” on page 41. The following table lists the keyboard
shortcuts that you can use to navigate the up and down arrows in the spin box.

Keys Function

up arrow or down arrow Increase or decrease the value of the spin box by a
small amount.

Page Up or Page Down Increase or decrease the value of the spin box by a
large amount.

To Navigate Drop-Down List Boxes
A drop-down list box is a control that you use to select one of several available items.
The drop-down list box contains a button that you use to display the available items.

FIGURE 3–8 Sample Drop-Down List Box

The following table lists the keyboard shortcuts that you can use to navigate a
drop-down list box.

Keys Function

spacebar This key performs one of the following functions:
� If the drop-down list is not open, this key opens

the drop-down list.
� If the drop-down list is open, this key accepts the

current selection and closes the list.

up arrow Select the previous list item.

down arrow Select the next list item.

Esc Close the list without changing the selection.

To Navigate Drop-Down Combination Boxes
A drop-down combination box is a text box with a drop-down list box attached.
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FIGURE 3–9 Sample Drop-Down Combination Box

When the text box has focus, use the keyboard shortcuts that are listed in “To Navigate
Text Boxes” on page 41 to navigate the text box area. When the text box has focus, you
can also use the keyboard shortcuts in the following table to navigate the drop-down
list area.

Keys Function

up arrow Select the previous item from the drop-down list
without displaying the list.

down arrow Select the next item from the drop-down list without
displaying the list.

Ctrl+ down arrow Open the drop-down list.

When the drop-down list has focus, you can use the keyboard shortcuts that are listed
in the following table to navigate the drop-down list.

Keys Function

up arrow Select the previous list item.

down arrow Select the next list item.

Home Select the first item on the list.

End Select the last item on the list.

Page Up Select the item at the top of the current list view.

Page Down Select the item at the bottom of the current list view.

spacebar Accept the current selection and close the
drop-down list.

Ctrl+Page Up Scroll to the left of the list, if required.

Ctrl+Page Down Scroll to the right of the list, if required.

To Navigate Sliders
A slider is a control that you use to set a value in a continuous range of values.
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FIGURE 3–10 Sample Slider

The following table describes the keyboard shortcuts that you can use to navigate a
slider.

Keys Function

left arrow or up arrow Move the slider left or up by a small amount.

right arrow or down arrow Move the slider right or down by a small amount.

Page Up Move the slider left or up a large amount.

Page Down Move the slider right or down a small amount.

Home Move the slider to the maximum value.

End Move the slider to the minimum value.

To Navigate Tabbed Sections
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FIGURE 3–11 Sample Dialog with Tabbed Sections

Windows and dialogs are sometimes divided into logical sections that are displayed
one section at a time on the window or dialog. The divisions are called tabbed sections
that are identified by a tab with a text label.

The following table lists the keyboard shortcuts that you can use to navigate the
tabbed sections of a window or dialog when a tab name has focus.

Keys Function

left arrow Give focus to the previous tabbed section.

right arrow Give focus to the next tabbed section.

Tab or
Ctrl+down arrow

Give focus to the first control on the active tabbed
section.

The following table lists the keyboard shortcuts that you can use to navigate the
tabbed sections of a window or dialog when a control on a tabbed section has focus.
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Keys Function

Ctrl+ Page Up Give focus to the previous tabbed section.

This keyboard shortcut does not work if the focused
control uses Ctrl+ Page Up for another purpose.

Ctrl+Page Down Give focus to the next tabbed section.

This keyboard shortcut does not work if the focused
control uses Ctrl+ Page Down for another purpose.

Ctrl+Tab Give focus to the next control outside the tabbed
sections.

To Navigate Lists
The following table lists the keyboard shortcuts that you can use to navigate
multi-column lists when a column header has focus.

Keys Function

left arrow or right arrow Give focus to the previous or next column header.

spacebar Activate the header. This action usually sorts the list
by the column header.

Tab Give focus to the list contents.

The following table lists the keyboard shortcuts that you can use to navigate lists
when the contents of the list has focus.

Keys Function

arrow keys Select the next or previous row or column.

Page Up Select the top row of the list contents that are in
view. Press Page Up again to select the top row of
the previous view.

Page Down Select the bottom row of the list contents that are in
view. Press Page Down again to select the bottom
row of the next view.

Home Select the first row in the list.

End Select the last row in the list.
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Keys Function

Shift+arrow keys For lists that support multiline selections, add the
next or previous row or column to the current
selection.

For lists that only allow single line selections, select
the next or previous row or column.

Shift+Page Up Select all the rows between the current selection and
the top row of the view.

Shift+Page Down Select all the rows between the current selection and
the bottom row of the view.

Shift+Home Select all the rows between the current selection and
the first row in the list.

Shift+End Select all the rows between the current selection and
the last row in the list.

Ctrl+arrow keys Give focus to the next row or column but do not
extend the selection.

Ctrl+Page Up Give focus to the top row in the view but do not
extend the selection.

Ctrl+Page Down Give focus to the bottom row in the view but do not
extend the selection.

Ctrl+Home Give focus to the first row in the list but do not
extend the selection.

Ctrl+End Give focus to the last row in the list but do not
extend the selection.

Ctrl+spacebar Add the focused row to the selection or remove the
focused row from the selection.

spacebar If the selected item is a text box, this key enables you
to edit the item.

If the selected item is a check box, this key enables
you to select or deselect the check box.

Return Activate the item.

Ctrl+A For lists that support multiline selections, select all
rows in the list.

Shift+ Tab Give focus to the column header, if applicable.

Chapter 3 • Using the Keyboard to Navigate the Desktop 49



To Navigate Trees
A tree is a user interface control that contains sections that you can expand and
collapse. A tree usually represents a hierarchical structure.

FIGURE 3–12 Sample Tree Structure

To navigate trees, you can use the same keyboard shortcuts that are listed in “To
Navigate Lists” on page 48. In addition, the following table lists the keyboard
shortcuts you can use for the tree items.

Keys Function

+ (plus) Expand the focused item.

- (minus) Collapse the focused item.

Back Space Select the parent item.

Customizing Your Keyboard Shortcuts
Use the Keyboard Shortcuts preference tool to display the default keyboard shortcuts
that you use to navigate the desktop. You can customize the default keyboard
shortcuts to meet your requirements. You can also create hot keys. Hot keys are
keyboard shortcuts that start applications.

To start the Keyboard Shortcuts preference tool, choose Applications → Desktop
Preferences → Keyboard Shortcuts. The Desktop shortcuts table lists the keyboard
shortcut that is associated with each action.

To customize a keyboard shortcut, perform the following steps:
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1. Click on the action for which you want to customize the keyboard shortcut. The
row is highlighted.

2. Click on the keyboard shortcut in the Shortcut column. The following text is
displayed in the Shortcut column:

Type a new accelerator, or press Backspace to clear

3. Press the keys that you want to associate with the action. The new keyboard
shortcut is displayed in the Shortcut column.

To disable a keyboard shortcut, perform the following steps:

1. Click on the action for which you want to disable the keyboard shortcut. The row
is highlighted.

2. Click on the keyboard shortcut in the Shortcut column. The following text is
displayed in the Shortcut column:

Type a new accelerator, or press Backspace to clear

3. Press Back Space. The keyboard shortcut is disabled.
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CHAPTER 4

Customizing the Appearance of the
Desktop

This chapter describes the methods you can use to change the appearance of the
desktop to enhance the accessibility of the desktop for users with visual impairments.

Customization Options
There are a number of methods to enable you to customize the appearance of the
desktop to suit your specific needs, as follows:

Themes
Themes are the most effective way to change the appearance of the desktop in a
consistent manner. See “Using Themes to Customize the Desktop” on page 54 for
more information about themes and how to use themes to achieve the type of
desktop that you require.

Desktop and application-specific configuration settings
You can customize different components of the desktop individually to achieve the
display settings that you require. You can configure the desktop and applications in
addition to using themes or as an alternative to using themes. See “Customizing
Specific Components of the Desktop” on page 56 for more information.

The following table summarizes the changes that you can make to the desktop and
where you can make the changes. This manual does not provide detailed instructions
about how to customize the desktop. For detailed instructions about how to use the
customization tools that the desktop provides, refer to the online help for each tool or
to the GNOME 2.0 Desktop for the Solaris Operating Environment User Guide.
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TABLE 4–1 Quick Reference to Customizing the Appearance of the Desktop

To change the... Use...

Overall appearance of the desktop to use high contrast colors, low
contrast colors, or large print.

The Theme preference tool.

Appearance of the desktop background only. The Background
preference tool and the
Nautilus file manager
Preferences dialog.

Font displayed on the desktop background and in all desktop
applications.

The Font preference tool.

Default font settings of the gedit text editor or Terminal
application. By default, gedit and Terminal use the default
application font that is specified in the Font preference tool.

The Preferences dialog for
the application.

Appearance of icons and tabs in the Nautilus file manager
application.

The View menu and the
Preferences dialog in the
Nautilus file manager
application.

Using Themes to Customize the Desktop
This section describes how to use themes to customize the appearance of the desktop.

Introduction to Themes
You can use themes to modify and control the appearance of the desktop in a
consistent manner. A theme is a group of coordinated settings that specifies how a
desktop component or a group of desktop components appears. When you apply a
theme, the system modifies many desktop components simultaneously to achieve the
desired effect. For example, if you apply a theme that increases the font size across the
desktop, the theme also modifies the size of panels and icons on the desktop for
optimum compatibility with the font size.

The following types of themes affect different parts of the desktop:

Desktop themes Desktop themes determine the visual appearance of
all windows, applications, dialogs, panels, and
applets. Desktop themes also determine the visual
appearance of the GNOME-compliant interface
items that appear on windows, panels, and applets,
such as menus, icons, and buttons. Some of the
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desktop themes that are available in the desktop are
designed for special accessibility needs.

Window frame themes Window frame themes determine the appearance of
the frames around windows only.

Nautilus file manager themes Nautilus file manager themes determine the
appearance of desktop background objects, Nautilus
icons, and the font used on tabs in the Nautilus side
pane.

To Choose a Desktop Theme
To open the Theme preference tool and view the desktop themes that are available,
choose Applications → Desktop Preferences → Theme. The Theme Preferences dialog
is displayed. Click on the Widget Theme tab to display the desktop themes that are
available. To choose a new theme for the desktop, click on a theme in the Widget
Theme list box. The system automatically applies the theme to the desktop.

There are several desktop themes available that suit different accessibility needs. These
themes are described in the following table:

TABLE 4–2 Desktop Themes Designed for Accessibility Requirements

Theme Name Description

HighContrast Provides dark text on a light background
using high contrast colors.

HighContrastInverse Provides light text on a dark background
using high contrast colors.

LowContrast Uses low contrast colors for the background
and foreground text.

LargePrint Increases the font size to 18pt. The
background and foreground colors are the
same as those specified by the Default
desktop theme.

HighContrastLargePrint Provides dark text on a light background
using high contrast colors and increases the
font size to 18pt.

HighContrastLargePrintInverse Provides light text on a dark background
using high contrast colors and increases the
font size to 18pt.
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TABLE 4–2 Desktop Themes Designed for Accessibility Requirements (Continued)
Theme Name Description

LowContrastLargePrint Uses low contrast colors for the background
and foreground text and increases the font size
to 18pt.

To Choose a Window Frame Theme
To open the Theme preference tool and view the window frame themes that are
available, choose Applications → Desktop Preferences → Theme. The Theme
Preferences dialog is displayed. Click on the Window Frames tab to display the
window frame themes that are available. The Atlanta theme is an accessible theme.

To Choose a Nautilus Theme
Nautilus file manager themes determine the appearance of desktop background
objects, Nautilus icons, and the font used on tabs in the Nautilus side pane. To select a
Nautilus theme, perform the following steps:

1. Start the Nautilus file manager.

2. Choose Edit → Preferences to display the Preferences dialog.

3. Click on the Appearance category to display the Nautilus themes that are
available. The accessible Nautilus themes correspond to the accessible desktop
themes that are listed in Table 4–2.

4. Select the theme that matches the desktop theme that you selected.

To Create Your Own Themes
For information about how to create your own desktop themes and window frame
themes, see the GNOME 2.0 Desktop for the Solaris Operating Environment System
Administration Guide.

Customizing Specific Components of the
Desktop
This section describes how to customize specific components of the desktop
individually.
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To Customize the Desktop Background
The desktop themes do not affect the desktop background. Therefore to modify the
desktop background to complement your desktop, you must customize the desktop
background separately using the Background preference tool. To start the Background
preference tool, choose Applications → Desktop Preferences → Background.

To Customize Desktop Background Objects
The size of the icons that are displayed on the desktop background is controlled by the
Nautilus file manager. To change the size of the icons, perform the following steps:

1. Start the Nautilus file manager.

2. Choose Edit → Preferences..

3. Select the Views category.

4. In the Icon View Defaults group, select the zoom level that you require in the
Default zoom level spin box.

To Customize Fonts
This section describes how to customize the font settings for the desktop and
frequently-used applications.

If you have difficulty with the default font type and font size that is used on the
desktop and desktop background, you can customize the font settings to suit your
needs.

You can specify individual font settings for the following desktop components and
applications:

� Entire desktop excluding the desktop background
� Desktop background only
� Terminal
� gedit text editor
� Nautilus file manager

To Customize the Desktop Fonts
The Font preference tool allows you to specify the default fonts for the desktop.

To start the Font preference tool, choose Applications → Desktop Preferences → Font.
The Font Preferences dialog contains the following options:
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Application font Click on this button to select a default font to use for the text that
is displayed on the desktop, including the text displayed on the
windows and dialogs associated with GNOME-compliant
applications and applets.

Note – If you use the Theme preference tool to select a theme that
modifies the application font, the theme setting overrides the
font that you select using the Font preference tool.

Desktop font Click on this button to select a font to use for the text that is
displayed on the desktop background only.

Note – If you use large fonts, you may need to change the size of panes in applications
that use panes such as, Nautilus file manager and Yelp.

To Customize the Terminal Font
By default, the Terminal application uses the default font settings that are specified in
the Font preference tool to display the text in the Terminal window components such
as the titlebar, toolbar, menubar, and application dialogs. However, Terminal uses
fixed-width fonts to display the contents of the Terminal window, that is the text that
is displayed at the command line.

To change the font settings for the contents of the Terminal window, start the Terminal
application, then choose Edit → Current Profile. In the General tabbed section, specify
a font for the window contents as follows:

1. Deselect the Use the same font as other applications option.

2. Click on the font selector button to select the font type and font size to use for the
contents of the Terminal window.

To Customize the gedit Text Editor Font
By default, the gedit application uses the default font settings that are specified in the
Font preference tool to display the text in the gedit window components such as the
menubar, toolbar, and application dialogs. However, you can customize the font that
gedit uses to display the text editor window contents. To customize the font settings
for the gedit window contents, perform the following steps:

1. In the gedit application, choose Edit → Preferences.

2. In the Preferences dialog, select the Fonts & Colors category.
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3. Perform one of the following steps:

� To use the default desktop font that is specified in the Font preference tool,
select the Use default theme font option.

� To specify a font, deselect the Use default theme font option, then click on the
Font used by the editor button to display the font selector dialog.

To Customize the Nautilus File Manager Font
By default, the Nautilus file manager uses the default font settings that are specified in
the Font preference tool to display the text in the file manager window. However, you
can further customize the font that is used in the file manager view pane. To
customize the font that is used in the view pane, click on the View menu in the file
manager, then select one of the following menu items:

� To enlarge the text, select Zoom In.
� To reduce the text, select Zoom Out.
� To reset the text to the default font setting, select Normal Size.

Meeting Specific Accessibility Needs
The following sections summarize the steps you need to take to improve the
accessibility of the desktop in a particular area.

To Achieve a High or Low Contrast Desktop
To achieve a high or low contrast desktop, perform the following steps:

1. Use the Theme preference tool to select the high contrast or low contrast desktop
theme that you require.

2. Use the Theme preference tool to select a window frame theme. You should select
the Atlanta window frame theme for use with high contrast desktop themes. The
Atlanta window frame theme may also improve readability for some users.
However, you can choose the window frame theme that best suits your needs.

3. In the Nautilus Preferences dialog, select a Nautilus theme to match the high
contrast or low contrast desktop theme that you selected. See “To Choose a
Nautilus Theme” on page 56 for more information.

4. Use the Background preference tool to customize your desktop background as
follows:
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� Set the Picture Options to No Picture.
� Set the Background Style to Solid color.
� Select a background color that suits your needs.

5. In the Terminal application, ensure that the Use colors from system theme option
is selected in the Edit Profile dialog.

6. In the gedit application, ensure that the Use default theme colors option is selected
in the Preferences dialog.

To Achieve a Large Print Desktop
To achieve a large print desktop, perform the following steps:

1. Use the Theme preference tool to select the large print theme that you require.

2. Use the Theme preference tool to select a window frame theme. You can use the
Crux, Atlanta, or Bright window frame themes with large print desktop themes,
depending on the contrast level that you prefer.

3. Use the Font preference tool to increase the font that is displayed on desktop
background objects.

4. In the Nautilus Preferences dialog, select a Nautilus theme to match the large print
desktop theme that you selected. See “To Choose a Nautilus Theme” on page 56 for
more information.

5. Increase the font size that is used to display the contents of the Terminal
application window. See “To Customize the Terminal Font” on page 58 for more
information.

6. If the Use default theme font option is selected in the gedit Preferences dialog,
gedit uses the font size that is specified in the large print theme that you selected.
However, if the Use default theme font option is not selected, increase the font size
that is used to display the contents of the gedit text editor window. See “To
Customize the gedit Text Editor Font” on page 58 for more information.

7. If you use applications that use panes, such as Nautilus file manager and the Help
browser, you may need to change the size of panes to accommodate the large print.
See the online help for the appropriate application for more information.
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